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Introduction 

What is PhonEX Pro Guard?  
Strict monitoring of telephone and network use is critical for any 
telecommunications manager. PhonEX Pro Guard provides sophisticated 
tools that can detect and filter unauthorized usage. PhonEX Pro Guard can be 
programmed to warn you of violations and can be set to act when critical 
alarms are set off. 

The PhonEX Pro Guard works together with PhonEX Pro and accesses 
information stored and processed by the system. This module is completely 
integrated within PhonEX Pro and takes full advantage of the system’s 
database and processing capabilities. 

Requirements 
PhonEX Pro Guard requires the following minimum system configuration: 

• Microsoft Windows 95 or Microsoft Windows NT operating system 

• PC with a Pentium 133 or higher processor 

• 16 megabytes (MB) of RAM 

• 3.5-inch high-density disk drive 

• 5 MB of free hard disk space 
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Main Window 

The PhonEX Pro Guard Main Window displays the inquiries defined for the 
system. These inquiries detect suspicious activity in your organization (for 
more information, see Inquiries, page 4). The Main Window is displayed 
when the program is invoked. 

 

PhonEX Pro Guard Main Window 

The Main Window is divided into the following sections: 

• Main menu 

• Toolbar 

• Alarm counters 

• Inquiries panel 

• Inactivity Tests panel 
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Toolbar 
The toolbar gives you quick access to functions used to manage system 
inquiries. Each of the tasks on the toolbar affects the highlighted inquiry. A 
list of the buttons and the function of each appears below: 

Inquiry Information Button 
This function displays the inquiry definition and recent call data. To view 
information for an inquiry, select the inquiry and click this button. See 
page 13 for a complete description of this function.  

 

Clear Inquiry Button 
Inquiry Information is stored in the system and can be viewed at any time. 
You can choose to clear the values displayed for an inquiry. To clear an 
inquiry, select the inquiry and click this button. You will be prompted 
before the information is removed. 

Update Inquiry Button 
Inquiries, once defined, can be updated and revised. To update an inquiry, 
select the inquiry and click this button. For more information on updating 
an inquiry, see Defining New Log Inquiries, page 13. 

 

Inquiries List / Inactivity Test Trunks List Buttons 
The information displayed in the Inquiries panel and the Inactivity Tests 
panel can be generated as standard PhonEX Pro reports. To view this 
report in the Report viewer, click this button in the appropriate panel. 

 

Alarm Counters 
These counters appear to the upper right of the Inquiries panel and the 
Inactivity Tests panel. They display the number of alarms that have been 
triggered. If no alarms have been triggered, the message, “ All Inquiries are 
OK” (or “All Tested Trunks are OK” for the Inactivity Tests panel) will be 
displayed. 
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Inquiries Panel 
The Inquiries panel contains a complete list of the inquiries defined in the 
system. This list displays the Warning Level, Status, Total Calls, Total Cost, 
and Total Duration defined for each inquiry. The list of inquiries can be 
sorted according to your preference (see Sorting, below). 

Status 
Each inquiry has a given status. This status indicates whether or not the 
inquiry is active, and if an alarm has been triggered by the inquiry. The 
following statuses exist: 

OK  The inquiry is active. No alarms have been triggered. 

Alarm  The inquiry is active. An alarm has been triggered. 

Empty  The inquiry is disabled. 

 

Inactivity Tests Panel 
The Inactivity Tests panel contains current data for the inactivity tests defined 
in the system. This list displays the Trunk Group, Trunk, Warning Level, 
Status, last CDR call, and last test call made to the trunk. 

Sorting 
You can sort the display of inquiries according to name, alarm level, or status. 
To sort according to one of these criteria, select Sort from the View menu, 
and then select the desired sort criterion. 

Saving the Layout 
When the system is started up, the Main Window is displayed according to 
the saved layout. If you do not save the layout, the system will revert to its 
default sorting method. To save the current layout, select Save Layout from 
the View menu. 
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Inquiries 

An inquiry defines a specific set of parameters that are matched against 
information processed by the system. Call inquiries track specified parameters 
in calls made through the system. Log inquiries track specified parameters in 
log files which are transmitted with the CDR files. An alarm is assigned to 
thresholds for each inquiry. 

Inquiries are defined to sample calls in a specified range over a given period 
of time. For example, you can define an inquiry which, every three hours, 
samples all Outgoing  Calls whose duration exceeds two hours. You can then 
define an alarm to be triggered when a set of thresholds has been exceeded. 

In the case of call inquiries, you may want to investigate international calls 
originating from a particular extension after normal working hours. You can 
define a call inquiry that polls that extension, focusing on calls made after a 
given time, and that triggers an alarm when certain conditions occur. 

In the case of log inquiries, you may want to trigger an alarm whenever a log 
file returns text which includes a “no trunks” message. You can define a log 
inquiry which searches for that text. To define a new log inquiry, see Defining 
New Log Inquiries, page 13. 
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Defining New Call Inquiries 
To begin defining a new call inquiry, select New from the Inquiry menu, and 
then select New call inquiry. The New Call Inquiry dialog box is displayed: 

 

New Call Inquiry dialog box 

A call inquiry is defined by the following parameters: 

Inquiry Definition 
Name 
Type a name (45 characters maximum) that describes the inquiry. 

Alarm Level 
The system offers four alarm levels  (Warning, Minor, Major, Critical). Each 
of these alarm levels can be assigned a given reaction (see Alarm Operations, 
page 17). Assign the inquiry an alarm Level. 

Inquiry Period 
You can define the length of time over which you wish to sample calls. The 
values chosen for summary thresholds (see below) are sampled over this 
period of time. Select the unit of time to be used (Minutes or Hours), and then 
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type the value for this unit in the Inquiry Period field. 

Disable 
You can suspend the operation of a given inquiry while saving its parameters 
for future use. To disable an inquiry, select the Disable check box. Disabled 
inquiries are displayed in the system Main Window, but only their names and 
alarm levels are displayed. 

To reactivate an inquiry, clear the Disable check box. The inquiry will be 
activated the next time data is processed. 

Summary Thresholds 
Over a given inquiry period, the total cost, number of calls, and duration of 
calls that fall within the boundaries of the inquiry are compared with the 
summary thresholds. 

To view the thresholds set for an inquiry, double click that inquiry in the main 
window. The inquiry information is displayed, including summary thresholds. 

Summary thresholds are inclusive. This means that all of the thresholds must 
be exceeded in order to trigger an alarm. If only one or two of these 
thresholds are exceeded, no alarm is triggered. 

Enter data in the following fields: 

Total Cost 
Type the total acceptable cost for calls made during the inquiry period. Cost 
units are determined by settings in PhonEX Pro (see International in the 
PhonEX Pro documentation). 

Total Duration 
Type the total acceptable duration for calls made during the inquiry period, 
using HH:MM format. For example, type 02:15 for two hours and fifteen 
minutes. 

Total Calls 
Type the total acceptable number of calls made during the inquiry Period. 
This value is compared with the number of calls that fall under the Suspicious 
Calls Criteria (see below). 

Activate Alarm Below/Above Thresholds 
Select Below Thresholds to trigger an alarm when none of the thresholds are 
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reached. Select Above Thresholds to trigger an alarm when all of the 
thresholds are exceeded. 

Suspicious Calls Criteria 
This panel defines the parameters for calls included in the inquiry. A call 
must match all of the criteria to be included from the inquiry. You can set a 
number of criteria for each inquiry 

Adding New Call Criteria 
To add a new criterion to the inquiry, click Add. The Suspicious Call Criteria 
dialog box is displayed: 

 

Suspicious Call Criteria dialog box 

Enter data in the following fields: 

Field 
Click to select a system field from the drop-down list. These fields are part of 
your system database. Be aware that calls may not have values for every field. 
For instance, some calls may not have an associate account, but every call has 
a duration. The value of this field for each call is compared with the target 
value (see below). 

The following fields are available: 

• Account 

• Date 
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• Time 

• Call type (see Defining Call Types, page 10) 

• Cost 

• Day: When you select this field, the ellipsis button  is displayed next 
to the Value field. Click this button to display the Days List dialog box: 

 

Days List dialog box 

Click to select any day of the week. Click  to add that day to the 
Value field. Click  to remove that day from the Value field. Click  
to close the Days List dialog box. 

• Destination 

• Duration 

• Extension 

• Trunk Group 

• Trunk 

Operation 
This field contains the operant in an expression that compares the selected 
field and the target value. The available operant vary, depending on the field 
selected. For each call processed, the value of the field is compared with the 
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target value. If a defined criterion is met, and the call data fall within any 
other defined criteria, then the call will be included in the inquiry. 

Select the operant from the list of choices. 

Value (Target Value) 
This parameter is compared with the field data for each call that is processed. 
The format of this value depends upon the Field selected.  

Dialog Box Help Text 
The Suspicious Call Criteria dialog box contains Help text for each specific 
field type. For example, if you select Date for the Field, the text will prompt 
you to type the date in the proper date format. 

Updating Call Criteria 
To update a criterion, select the criterion to update and click Update. The 
Suspicious Call Criteria dialog box is displayed. Modify the settings as 
required, and then click OK, or click Cancel to close the dialog box without 
making changes. 

Deleting Call Criteria 
To delete a criterion, select the criterion to delete, and then click Delete. You 
will be prompted to confirm the deletion. Click Yes to delete the criterion, or 
No to leave the data as it is. 

Defining Call Types 
When you select the Call Type field for suspicious calls criteria, the ellipsis 
button  is displayed next to the Primary Type field. Click this button to 
display the Call Type dialog box: 
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Call Type dialog box 

Select one of the following primary call types: 

• Out: Outgoing calls from your PBX 

• In: Incoming calls to your PBX 

• Local: Calls from extension to extension within your organization 

Select secondary call types to be included or excluded from the inquiry by 
selecting check boxes next to call types. Select a check box under the = 
column to include the call type in the inquiry. Select the check box under the 
≠ column to exclude the call type. 

Select from the following types: 

• Start: Calls that originate transfers 

• End: Calls that terminate transfers 

• Conference: Calls that simultaneously involve more than two extensions 
or destinations 

• Trunk: Tie calls from one trunk group to another 

• DISA: Calls made from one extension but charged to a different 



Inquiries 

Page 12 PhonEX Guard User’s Guide 

extension through the charge code assignment 

• Abandoned: Calls that are started but not completed 

• Transferred: Calls that are transferred between extensions 

• Forwarded: Calls that are automatically forwarded or diverted to another 
extension. The extension that the call reaches is not the extension 
originally dialed by the caller. 

• Personal: Personal calls 

For example, if you select the following settings, all outgoing Start calls, 
outgoing DISA calls, and outgoing Abandoned calls are included in the 
report, but no Personal calls are included: 

 
Call Types example 

Click  to save your selections. The Suspicious Calls Criteria dialog box is 
updated with the selected call types, in the following fields: Primary Type,, 
Include, and Exclude. 
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Defining New Log Inquiries 
To begin defining a new log inquiry, select New from the Inquiry menu, and 
then select New log inquiry. The New Log Inquiry dialog box is displayed: 

 

New Log Inquiry dialog box 

A log inquiry is defined by the following parameters: 

Name 
Type a name (45 characters maximum) that describes the inquiry. 

Alarm Level 
The system offers four alarm levels  (Warning, Minor, Major, Critical). Each 
of these alarm levels can be assigned a given reaction (see Alarm Operations, 
page 17). Assign the inquiry an alarm Level. 

Inquiry Period 
You can define the length of time over which you wish to sample calls. The 
values chosen for summary thresholds (see below) are sampled over this 
period of time. Select the unit of time to be used (Minutes or Hours), and then 
type the value for this unit in the Inquiry Period field. 
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Disable 
You can suspend the operation of a given inquiry while saving its parameters 
for future use. To disable an inquiry, select the Disable check box. Disabled 
inquiries are displayed in the system Main Window, but only their names and 
alarm levels are displayed. 

To reactivate an inquiry, clear the Disable check box. The inquiry will be 
activated the next time data is processed. 

Total Calls 
Type the total number of calls required during the inquiry Period to activate 
the log inquiry. For example, you can define a log inquiry to search for a 
“trunk does not respond” response in the log text only if at least 100 calls are 
included in the log. 

Mask Definition 
Type the log text to be searched for in the Mask field. The Legal Commands 
panel displays all of the commands which can be used in this field. For 
example, to search for all text including the word “error”, type * error * in 
the Mask field. 

Testing the Mask Definition 
Click Test  to test the mask definition. The Mask Test dialog box is 
displayed. Type the line to be tested in the Line To Test field. The Test 
Result field displays Test succeeded or Test failed, depending on the result 
of the test. 

Updating Inquiries 
To update an inquiry (call or log), select the inquiry to update, and then select 
Update from the Inquiry menu. The Inquiry Update dialog box is displayed. 
Modify the settings as required, and then click OK, or click Cancel to close 
the dialog box without making changes. 

Deleting Inquiries 
To delete an inquiry (call or log), select the inquiry to delete, and then select 
Delete from the Inquiry menu. You will be prompted to confirm the deletion. 
Click Yes to delete the inquiry, or No to leave the data as it is. 
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Viewing Inquiry Information 
Each inquiry records the number of calls that match the parameters defined 
for the inquiry. In the case of call inquiries, the system also tracks the total 
cost and duration included in the inquiry. 

To view these totals, the summary thresholds, and a list of matching calls in 
the inquiry from the previous inquiry period, select an inquiry (call or log), 
and then select Information from the Inquiry menu. The Inquiry Information 
dialog box is displayed: 

 

Inquiry Information dialog box 

The upper part of the dialog box contains the name of the inquiry, the 
summary thresholds, and some of the inquiry definitions. 

The lower part of the dialog box contains a list of calls (from the previous 
inquiry period) included in the inquiry. This list can be scrolled to view 
specific call data. 

Clearing Totals 
If you want to clear the current values of a given inquiry (call or log), select 
the inquiry and select Clear Totals from the Inquiry menu. You will be 
prompted before the totals are cleared. 

Exiting PhonEX Pro Guard 
If you exit the system, PhonEX Pro Guard will not be able to trigger alarms, 
and will suspend toll fraud detection. To exit the system, select Exit from the 
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Inquiry menu. You will be prompted for your user name and password before 
PhonEX Pro Guard closes. 
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Tools 

PhonEX Pro Guard provides Tools to monitor the following functions: 

• Alarm operations 

• Inactivity tests 

• Online activity 

Alarm Operations 
The system has four defined warning levels, or alarms. Each of these alarms 
can be customized to suit your needs. To edit the definition of an alarm, select 
Alarm Operations from the Tools menu. The Alarm Operations List is 
displayed: 

 

Alarm Operations List 

Updating Alarm Definitions 
To update the current definition of an alarm, select the alarm and click 
Update. The Alarm Operations dialog box for that alarm level is displayed: 
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Alarm Operations dialog box 

Alarm Level 
The alarm level is displayed in this field, which cannot be edited. To modify a 
different alarm level, return to the Alarm Operations List and select another 
level. 

Description 
Type a description of the alarm. 

Execute File 
When call data triggers an alarm, you may want the system to take action. In 
addition to the visual alarm displayed on the monitor, you can define an 
action to be triggered along with the alarm. This action opens an executable 
file (with the suffix exe, bat, or com). Type the path and file name of the file 
to be opened when the alarm is triggered. 

To browse for the file, click . The standard Windows File dialog box is 
displayed. Select the file to be executed, and then click OK. 

Parameters 
If the Execute File that is triggered by the alarm requires a parameter, type the 
parameter in this field. To select a predefined parameter, click . The 
Operation Parameters dialog box displays the following two options: 

• Alarmed inquiries log file name: Select this parameter to apply the 
Execute File to the list of all previously recorded inquiries which 
triggered alarms. This can be useful if alarms are registered over a long 
period without user intervention (for example, at nighttime). 
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• Triggering inquiries log file name: Select this parameter to apply the 
Execute File to the list of inquiries which triggered the most recent 
alarm. This list can include several inquiries. 

Clearing Alarm Definitions 
To clear all current alarm definitions, click Clear. You will be prompted 
before the definitions are cleared. 

Inactivity Tests 
PhonEX Pro Guard can check any trunk in the system for inactivity. To 
define inactivity tests, select Inactivity Test from the Tools menu. The 
Inactivity Test dialog box is displayed: 

 

Inactivity Test dialog box 

Enter data in the following fields: 

Port 
Select the port connected to the modem used for the test. 

Modem 
Select the modem used for the test from the drop-down list. 

Modem Settings 
To add a new modem, update settings for an existing modem, or delete a 
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modem, click Settings. The Modems List dialog box is displayed: 

 

Modems List dialog box 

Defining New Modems 
To add a new modem to the list of defined modems, click Add. The Modem 
Configuration Strings dialog box is displayed: 

 

Modem Configuration Strings dialog box 

Enter data in the following fields: 
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Name 
Type the name of the modem. 

Commands 
Each field displays a default string for that command. You can use this 
default, or type a different string according to your modem’s user manual. 

Return Codes 
Each field displays a default message for that situation. For example, the 
default message for a busy signal is BUSY. You can use this default, or type a 
different text. 

Updating Modem Settings 
To update settings for a modem, select the modem to update and click 
Update. The Modem Configuration Strings dialog box is displayed. Modify 
the settings as required, and then click OK, or click Cancel to close the 
dialog box without making changes. 

Deleting Modems 
To delete a modem, select the modem to delete, and then click Delete. You 
will be prompted to confirm the deletion. Click Yes to delete the modem, or 
No to leave the data as it is. 

Test Trunks 
Type the duration in seconds of the test call. 

Number to Dial 
Type the phone number of the PBX to be tested for inactivity. 

Defining Test Trunks 
You can test inactivity for an entire PBX, or for specific trunks of the PBX. 
To define specific trunks to be tested, click More. The Inactivity Test Trunks 
dialog box is displayed: 
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Inactivity Test Trunks dialog box 

The Inactivity Test Trunks dialog box displays the following information: 

• Number to dial: the number of the trunk 

• T.G.: the trunk group to which the trunk is assigned 

• Trunk: a description of the trunk 

• Last test call: the date and time of the last test call made to that trunk 

• Last CDR call: the date and time of the last CDR call recorded from that 
trunk 

• Status: either Disabled or Alarmed 

Defining New Test Trunks 
To define a new test trunk, click Add. The New Test Trunk dialog box is 
displayed: 
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New Test Trunk dialog box 

Enter data in the following fields: 

Trunk Group 
Type the number of the trunk group. 

Trunk 
Type a description of the trunk. 

Number to Dial 
Type the number of the trunk. 

Alarm Level 
Select the level of the alarm triggered when inactivity is detected on the 
specified trunk. 

Interval After Last Call (Minutes) 
Type the number of minutes of inactivity on the specified trunk required to 
trigger an alarm. 

Disable 
You can suspend the operation of a given trunk test while saving its 
parameters for future use. To disable a trunk test, select the Disable check 
box. To reactivate a trunk test, clear the Disable check box.  

Updating Test Trunks 
To update a test trunk, select the test trunk to update and click Update. The 
Update Test Trunk dialog box is displayed. Modify the settings as required, 
and then click OK, or click Cancel to close the dialog box without making 
changes. 
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Deleting Test Trunks 
To delete a test trunk, select the test trunk to delete, and then click Delete. 
You will be prompted to confirm the deletion. Click Yes to delete the test 
trunk, or No to leave the data as it is. 

Alarm Level 
Select the level of the alarm triggered when inactivity is detected on the PBX. 

Interval After Last Call (Minutes) 
Type the number of minutes of inactivity on the PBX required to trigger an 
alarm. 

Disable 
You can suspend the operation of an inactivity test while saving its 
parameters for future use. If you disable the inactivity test for the PBX, then 
none of the tests defined for trunks on that PBX will be performed, even if 
those trunk tests are currently alarmed. 

To disable an inactivity test, select the Disable check box. To reactivate an 
inactivity test, clear the Disable check box.  

Online Activities 
This tool allows you to view call data as it is being processed by the system. 
To activate the Online Activity monitor, select Online Activity from the 
Tools menu. The Online Activity monitor displays the Extension, Date, Start 
Time, Duration, Cost, Call Type, Destination, and Destination Type for each 
call as it is executed. 

 

Online Activity monitor 

This display retains the call data until the monitor is closed. The data in this 
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window can be scrolled. 

You can resize the columns of the Online Activity monitor to allow viewing 
of data of varying lengths. For example, if your extension numbers have 10 
digits, you can increase the width of the Extension column. 

To save these column widths, select Save Layout from the Options menu. If 
you do not save the layout, then the next time you open the Online Activity 
monitor the columns will revert to their default widths. 

To close the Online Activity monitor, select Exit from the Options menu. 
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Help 

Online Help is available from the main menu bar. Additionally, you can 
receive immediate help from the PhonEX Pro Online Help tool by pressing 
F1 or clicking the Help button located in most dialog boxes. Help displays 
instructions, explanations, and an index of topics to choose from. A topic in 
Help is similar to a page in a book. 

You can bookmark a Help topic to make it easy to find again. Select Define 
from the Bookmark menu in Help, and type a name for the bookmark. Next 
time you want that Help topic, select its bookmark from the Bookmark menu, 
and the topic is immediately displayed. A complete description of the Help 
system can be found in the Windows User Guide. 

Within the main online Help menu, there are several other features: 

• For a list of major Help topics (like the table of contents in a book), 
select Contents from the Help menu, and then select a topic. Help 
displays a list of specific topics to choose from. 

• To display copyright information, select About… from the Help menu.
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